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Disclaimer

The information contained in this document is for general informational purposes only and does
not constitute an offer, solicitation, invitation or recommendation to buy or sell any futures
contracts or other products or to provide any investment advice or service of any kind. This
document is not directed at, and is not intended for distribution to or use by, any person or entity in
any jurisdiction or country where such distribution or use would be contrary to law or regulation or
which would subject Hong Kong Exchanges and Clearing Limited (“HKEX”), Hong Kong Futures
Exchange Limited (“HKFE”) (together, the “Entities”, each an “Entity”), or any of their affiliates, or
any of the companies that they operate, to any registration requirement within such jurisdiction or
country.

No section or clause in this document may be regarded as creating any obligation on the part of
any of the Entities. Rights and obligations with regard to the trading, clearing and settlement of any
futures contracts effected on HKFE shall depend solely on the applicable rules of HKFE and the
relevant clearing house, as well as the applicable laws, rules and regulations of Hong Kong.

Although the information contained in this document is obtained or compiled from sources
believed to be reliable, neither of the Entities guarantees the accuracy, validity, timeliness or
completeness of the information or data for any particular purpose, and the Entities and the
companies that they operate shall not accept any responsibility for, or be liable for, errors,
omissions or other inaccuracies in the information or for the consequences thereof. The
information set out in this document is provided on an “as is” and “as available” basis and may be
amended or changed. It is not a substitute for professional advice which takes account of your
specific circumstances and nothing in this document constitutes legal advice. Neither of the
Entities shall be responsible or liable for any loss or damage, directly or indirectly, arising from the
use of or reliance upon any information provided in this document.

Additional disclaimer for CES China 120 Index Futures

CES China 120 Index (“CES 120 Index”) are calculated and / or disseminated by China Securities
Index Company Limited (“CSIC”) on behalf of China Exchanges Services Company Limited
(“CESC”). Neither CESC nor CSIC guarantee (expressly or impliedly) the accuracy, completeness,
timeliness or fitness for a particular purpose of the CESC Index and/or the information contained
therein; nor do they accept any liability for any damages, loss, costs or expenses suffered by any
person arising from the use of the CESC Index and/or the information contained therein.
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Equity Indices Monthly Performance in July 2022

Sector Indices vs HSI / HSCEI

CES120 vs China Theme Indices

Index Name Index Name
Oil & Gas Index
HSCEI -10.2% - MSCI China A 50 Connect Index _
Banks Index -12.0% - =7
HS Mainland o HSCEI -10.2%
Properties Index 34-9% e
. % Change % Change
Equity Index Futures Access Codes ’ g
HS Mainland HS Mainland
Vendor HS Mainland Banks Properties Oil & Gas CES 120 HSI HSCEI
Bloomberg BMWA PPTA OGIA CESA HIA HCA
Refinitiv 0#HMBI: O#HMPI: 0#HMOI: O#HCHH: 0#HSI: O#HCEL:
WIND MBIF MPIF MOIF CHHF HSIF HHIF
ET Net MBI MPI MOI CHH HSI HHI

Data Source: Bloomberg

As at 29 July 2022
Information for reference only
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Equity Index Futures & Options
Hang Seng Index (HSI) Futures & Options

rS! Products HS! Options (YoY)
(2022 vs 2021)

Av erage Daily Volume Open Interest Av erage Daily Volume Open Interest

(No. of Contracts) (No. of Contracts)
o & 280,000 - pmm ADV (L-Axis) - 200,000 (N%g’gggafts) ADV (L-Axis) (N?I OZSOOT%%:S)
HSI Futures 152,726 (+10%) 143,379 (+20%) 240,000 Open Interest (R-Axis) Open Interest (R-Axis)
200,000 - ,\/ 150,000 45,000 - - 300,000
160,000 -
o - 100,000 30,000 - - 200,000
Mini-HSI Futures 109,947 (+11%) 20,630 (+26%) 120,000 -
80,000 1 - 50,000 15,000 - - 100,000
40,000 -
0 - -0 0~~~ +++++++——+0
HSI Options 25,317 (-4%) 99,016 (+21%) I IR IR S O & & 0 & O
U S S S S S
HSI Futures (MoM) HSI Options (MoM)
Mini-HSI Options 11,946 (+7%) 14,491 (+26%)
Av erage Daily Volume Open Interest Average Daily Volume Open Interest
(No. of Contracts) No. of C
(Nz%g‘gggafts)— ADV (L-Axis) _ (N?' 0588%3615) 45,000 -+ ADV (L-Axis) ( (20408%%8)
s Open Intergst (R-Axis) Open Interest (R-Axis)
HSI Futures
. 1,802 (+1255%) 60,887 (+1041% 150,000 - n - 150,000 - 300,000
Options ( ) ( ) I Vi LN | ot 30,000 -
100,000 - - 100,000 - 200,000

- 15,000 -
HSI Volatility 00 50,000 - - 50,000 \_/\/_—\— - 100,000

Index Futures 00)

0 - -0 0 0
.. - — = oan = 9 c S5 2SS
HSI Dividend 238585885853 738585858853
] 0, 0,
Point Index 49 (+63%) 3,021 (480%) ol | o0 2021 | 2022
Futures

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 29 July 2022
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Equity Index Futures & Options
HSI Futures & Options

Hang Seng Index HSI vs VHSI Price Level HSI & Top 5 Constituents

. Includes the largest and most ('000)
Index Description _ ’ . 24 40 140 -
liquid stocks listed in Hong Kong | e—HS|  —\HS| I e HS| Index — Tencent
Index Level 20,156.51 (As at 29 Jul 2022) HS.BC AlA
120 Meituan Baba
Index Volatility (30-Day Historical) | 25.6 22 | Y
Index Avg. Day High-Low Range 301.71 (Jul 2022) 100
HSCEI Correlation (2021) 0.987 20 - L 28
80 -
Hang Seng Index Futures 18 2o 60
o May-22  Jun-22  Jul-22 May-22 Jun-22 Jul-22
Contract Multiplier HK$50
Notional Value (1 Contract) HK$1.01Mn (As at 29 Jul 2022) Distribution of HSI Index Options Ol in Month-end
Call Put
. 7.
Transaction Cost* 37.6 - 34_2
5 344 8312
Stamp Duty N/A g 312 £.29.2
T 29.2 o 27.2
. o 27.2 LW
Trading Fee HK$10 / contract L 252 X535
& 232 £212
¢ 212 =i
SFC Levy HK$0.54 / contract = 196 & 19.6
P 1856 5 186
Commission Rate Negotiable é 17.6 2 17.6
c 16.6 = 16.6
. - 15.6 15.6
Margin as of 21 Jul 2022 HK$72,200 14.6 14.6
10.0 | T : . . 10.0 . : : .
0 1 2 3 4 0 1 2 3 4

Open Interest ('000) Open Interest ('000)

Data Source: HKEX, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 29 July 2022
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Equity Index Futures & Options
Hang Seng China Enterprises Index (HSCEI) Futures & Options

HSCEI Futures (YoY) HSCEI Options (YoY)
HSCEI Products ol

ADV
(2022 vs 2021) Av erage Daily Volume Open Interest  Average Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
200,000 - == ADV (L-Axis) - 600,000 120,000 + ADV (L-Axis) - 2,800,000
Open Interest (R-Axis) Open Interest (R-AXis)
L i - 2,400,000
HSCEI Futures 174,502 (+37%) 438,284 (+23%) 160,000 - 500,000 100,000 500000
- 400,000 80,000 - [ o
120,000 - - 1,600,000
- 300,000 60,000 -
80,000 - - 1,200,000
Mini HSCEI - 200,000 40,000 -
SC 14,889 (+9%) 6,243 (-10%) - 800,000
Futures 40,000 - - 100,000 20,000 + - 400,000
0 - -0 0 —/+ eSS 0
Q X O O O o Q X O O O o
. RS N RN
HSCEI Options 42,688 (-6%) 1,093,865 (+11%)
HSCEI Futures (MoM) HSCEI Options (MoM)

.. Av erage Daily Volume Open Interest  Average Daily Volume Open Interest
Mln-I HSCEI 2,444 (+45%) 12,959 (+60%) (No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
Options 275,000 | s ADV (L-AxiS) - 600,000 80,000 - ADV (L-Axis) - 2,000,000

Open Interest (R-Axis) Open Interest (R-AXis)
220,000 - I - 500,000
HSCEI Fut s00000 007 [ 1,500,000
utures L ’
e 11,001 (+708%) 404,214 (+376%) 165,000 -
ptions - 300,000 40,000 - ~ 1,000,000
110,000 -
- 200,000
HSCEI Dividend 55,000 - . 100000 20,000 - - 500,000
Point Index 1,507 (+28%) 56,325 (+6%) ’
Futures Toanzocan=>eg ° 0 0
o =% = — s —
2%028%§2<§%“ §§8§§§§§%§§3
2021 2022 2021 2022

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 29 July 2022
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Equity Index Futures & Options
HSCEI Futures & Options

HSCEI

Index Description

Index Level

Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range
Correlation with HSI, CES120 (2021)

Correlation with CSI300, FTSE A50
(2021)

Contract Multiplier

Notional Value (1 Contract)

Stam p Duty
Trading Fee

SFC Levy
Commission Rate

Margin as of 21 Jul 2022

Data Source: HKEX, Bloomberg

Comprises the largest and
most liquid H shares

6,885.48 (As at 29 Jul 2022)
30.2
117.91 (Jul 2022)

0.987,0.954

0.766,0.799

HK$50

HK$0.34Mn (As at 29 Jul 2022)

Transaction Cost*

N/A

HK$3.5 / contract
HK$0.54 / contract
Negotiable

HK$30,500

* All calculations are in HKD and exclude commission fees

Information for reference onlv

As at 29 July 2022

X

HSI vs HSCEI
105 -

e HS| e HSCEI

100 -
90 -

11-Jul

18-Jul  25-Jul

HSCEI & Top 5 Constituents

1409 _hscel —— Ping An
Tencent = CCB
Meituan Baba

120 -

100 ey

E-&Jé ?‘ % \%%
80
60
May-22 Jun-22 Jul-22

Distribution of HSCEI Index Options Ol in Month-end

Call

16.0 |
14.0
g 12.4
11.0
10.0
9.0
8.0
7.0
6.0
5.0
2.0

Index Strike Price (‘000

10 20 30 40
Open Interest ('000)

o A

= 6.0
5.0
2.0

Put
16.0
~14.0
o
S12.4
211.0
L
10.0
Lo
0 8.0
870
c T
-__

20 40 60 80
Open Interest ('000)

o



Weekly HSI & HSCEI Options Performance

Weekly HSI Options

Contract Multiplier

Liquidity Providers

Transaction Cost*

Stamp Duty
Trading Fee
SFC Levy

Commission Rate

HK$50

Akuna, Eclipse, I-Access, IMC, Maven,
Optiver

N/A
HK$10 / contract
HK$0.54 / contract

Negotiable

Weekly HSCEI Options
HK$50

Contract Multiplier

Liquidity Providers

Transaction Cost*
Stamp Duty

Trading Fee

SFC Levy

Commission Rate

Data Source: HKEX

Akuna, Eclipse, I-Access, IMC, Mawen,
Optiver

N/A
HK$3.5 / contract
HK$0.54 / contract

Negotiable

Volume
(No. of Contracts)

25,000 +
20,000 -
15,000
10,000

5,000

0

a7
5/7
6/7
77
8/7
11/7

Volume
(No. of Contracts)

12,000 +

8,000 -

4,000 -

® Weekly HSI Options
® Weekly HSCEI Options

12/7
13/7
14/7
15/7
18/7
19/7
20/7
21/7
2217
25/7
26/7
2717
28/7

==\ eekly HS| & HSCEI Options Call
=\ eekly HSI & HSCEI Options Put

Weekly HSI & HSCEI Options Volume

29/7

a/7
5/7
6/7
77
8/7
11/7

13/7
14/7
18/7
19/7
20/7
21/7
2217
25/7
26/7
2717
2817

An investment tool to manage short term event risk

* All calculations are in HKD and exclude commission fees

Information for reference onlv

As at 29 July 2022

X
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Equity Futures & Options
Single Stock Futures & Options

Single Stock Derivatives ADV (2022 vs 2021) _— No. of Single Stock Derivatives

Stock Futures 8,960 (-7%) 39,955 (+36%) Single Stock Futures
Stock Options 590,976 (-7%) 8,292,796 (+4%) Single Stock Options 124
Stock Futures (YoY) Stock Options (YoY) Latest and Future Developments
Av erage Daily Volume Open Interest ~ Average Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
121000 1 mmmm ADV (L-Axis) . r 451000 800,000 - ADV (L-Axis) ~ 10,000,000 Stock Futures
10.000 - Open Interest (R-Axis) s 40,000 Open Interest (R-Axi
' - 35,000 600,000 - - 8,000,000
8,000 - - 30,000 | 6.000.000 * Products
6.000 - " 25000 450 000 - e > 3 A-shares ETFs futures contracts
- 20,000 - 4,000,000 » Total 98 stock futures contracts
4,000 - - 15000 0 000 |
- 10,000 : - 2,000,000
2,000 -
Lokl
L = Lo 0 +——+————————-0
O O X o & O 4 NN NSRRI ¥
S S S S S S P U
Stock Futures (MoM) Stock Options (MoM) Stock Options
Av erage Daily Volume Open Interest Average Daily Volume Open Interest * Products ;
(No. of Contracts) (No. of Contracts) ~ (No. of Contracts) , (No. of Contracts) > 3 A-shares ETFs options contracts
_ mmmmm ADV (L-Axis) } 800,000 - ADV (L-Axis) - 16,000,000 P
14,000 Open Interoat (R-Axis) | 20000 Open Interest (R-Axis) » Total 124 stock options contracts
12,000 4 - 40,000
10,000 - ’ 600,000 \/\/\_’\— - 12000000, \arket Makers (MMs)
1 - 30,000
8,000 400,000 - . 8,000,000 » 3 types of market makers (PMM/ CQMM/
6,000 1 - 20,000 QRMM)
4,000 200,000 - - 4,000,000 » CQMM to provide 50 series continuous
- 10,000 .
2,000 guotations
01 0 0 > O > 0
oan = 9c e >N = oan c == cS
38285852433 362858522433
2021 2022 2021 | 2022

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 29 July 2022

X



Hang Seng TECH Index Futures and Options Performance

Hang Seng TECH Index Open Interest (as of 29 July 2022)

Index Description

Tracks the largest technology companies

listed in Hong Kong

Hang Seng TECH Index Futures & Options

HK$50 per index point
HK$217K (As at 29 July 2022)
Futures: 4; Options: 5

Contract Multiplier
Notional Value (1 Contract)

No. of Liquidity Providers

Transaction Cost*

Stam p Duty
Trading Fee
SFC Levy

N/A
HK$5.00 / contract
HK$0.54 / contract

Providing investors with a tool to manage their risk exposure
to Hong Kong-listed technology companies

Data Source: HKEX
* Exclude commission fees
Information for reference onlv

As at 29 July 2022

Open Interest
(No. of Contracts)

140,000 -
120,000 -
100,000 -
80,000 -
60,000 -
40,000

38828582 2283573

2021 | 2022 |

Average Daily Volume (as of July 2022)
ADV

(No. of Contracts)

100,000 -
80,000
60,000
40,000
20,000

0

2021 2022

Volume and Open Interest continue to growth

10



MSCI China A 50 Connect Index Futures Performance

MSCI China A 50 Connect Index Daily Volume

. Balanced representation from 11 sectors
Index Description

of top 50 China A shares Volume
(No. of Contracts)
Index Level 2,338.55 (As at 29 July 2022)
50,000 -
Index Volatility (30-Day Historical) | 21.6
40,000 -
Index Avg. Day High-Low Range 32.64 (July 2022)
30,000 -
CSI300 Correlation (2021) 0.978
20,000 -
FTSE A50 Correlation (2021) 0.976
10,000 -
) 0 -
MSCI China A 50 Connect Index Futures NN N N NN N N NI AT N N N N N N S N
< 0O OO0 AdNMSTLW 00 O dNLW OINN~NWOD
o - H H Hdd NN NNNNNN
Contract Multiplier US$25
Notional Value (1 Contract) US$0.06Mn (As at 29 July 2022) Daily Open Interest
Average Quote Size US$0.29Mn (5 Contracts) ol
(No. of Contracts)
29,000 -
Transaction Cost*
27,000 -
Stamp Duty N/A
Trading Fee US$0.5 / contract 25,000 -
SFC Levy US$0.07 / contract 23.000 -
Margin as of 21 Jul 2022 US$3,300
21,000 T T T T T T T T T T T T T T T T T T T 1
N L R o i
TN ORNRDAIANMNMITIODDOOO AW O N~ D O
o+ 1 NN NN NN NN
Sector-balanced exposure to China’s A-share market Risk management tool for diversified China portfolios

Data Source: HKEX
* All calculations are in USD and exclude commission fees
Information for reference onlv

As at 29 July 2022



MSCI Asia and Emerging Market Index Futures Performance

MSCI Asia and Emerging Market Index

Index Description

representation 38 DM and EM countries and

regional indices

MSCI Asia and Emerging Market Index Futures

Contract Multiplier
Notional Value (1 Contract)

No. of Liquidity Providers

Transaction Cost*
Stam p Duty

Trading Fee

SFC Levy

Average US$40
Average US$43K (As at 29 July 2022)
12

N/A
US$0.6-US$1.0 / contract
US$0.07 / contract

HKEX with the broadest suite of MSCI derivatives products
based in the Asian time-zone

Data Source: HKEX
* Exclude commission fees
Information for reference onlv

As at 29 July 2022

Open Interest (As of 29 July 2022)

Open Interest
(No. of Contracts)

90,000

80,000 -

70,000 -

60,000
© 2 g 2 Q|5 9 5§ 5B > £ 3
2 $ o 2 8|8 ¢ =< & 3

2021 | 2022 |

Average Daily Volume (As of July 2022)

ADV

(No. of Contracts)

40,000 -

30,000
20,000
10,000

0

2021 2022

Volume and Open Interest continue to growth
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MSCI AC Asia ex Japan NTR Index (AxJ) Futures Performance

Open Interest (29 July 2022)

Index Descriotion representation 2 DM countries (excl. Japan) Open Interest
& and 9 EM countries in Asia (No. of Contracts)
1,200 -
Index Level 531.93 (As at 29 July 2022)
1,000 -
Index Volatility (30-Day Historical) | 18.8 800 -
Index Avg. Day High-Low Range 6.50 (July 2022) 600 -
400 -
HSI Correlation (2021 0.934
( ) 200 A
HSCEI Correlation (2021) 0.921 0
2 2 g 2 Q| 9 5§ 5 > £ 5
o o
2 3§ 0 2 4|8 ¢ =<8 3"
MSCI AxJ Futures 2021 | 2022 |

Contract Multiplier
Notional Value (1 Contract)

Avg. Quote Size

US$100
US$53K (As at 29 July 2022)

US$0.27Mn (5 Contracts)

MSCI AxJ Combines Developed and Emerging Markets (Rebased to 100)

) _ _ ) MSCIAX] e MSCI China MSCI HK
Avg. Bid-Ask Trading Spread 0.9 index points (July 2022) 120 - MSCISG MSCl India - MSCI Indonesia
L T e N MSCl Korea o MSCI Malaysia MSCI Pakistan
Liquidity Providers Flow and 11 banks 110 4 MSCI Philippines - MSCI Taiwan, .- MSCI Thailand
100
Transaction Cost*
Tansacioncos [
Stam p Duty N/A
80 -
Trading Fee US$0.5 / contract
70 +
SFC Levy US$0.07 / contract
. 60 T T
Margin as of 21 Jul 2022 US$3,040 May-2022 Jun-2022 Jul-2022

MSCI AxJ is a well-established benchmark representing Asia

Futures contracts have relatively lower transaction costs : . :
regional (excluding Japan) equity market performance

Data Source: HKEX
* All calculations are in USD and exclude commission fees
Information for reference onlv

As at 29 July 2022



Hang Seng Mainland Banks Index Futures Performance

Hang Seng Mainland Banks Index (HSMBI) 5-Min Avg. Bid-Ask Spreads (29 July 2022)

i Desesiian 10 Iarg?st and @st representative HSMBI Futures
HKEX-listed mainland banks stocks

CEB Bank 6818.HK 0.42%

Minsheng Bank 1988.HK 0.41%

Index Volatility (30-Day Historical) | 19.5 ABC 1288.HK 0.39%
CITIC Bank 998.HK 0.37%
Bank of China 3988.HK 0.36%
HSI Correlation (2021) 0.658 Bankcomm 3328.HK 0.25%
ICBC 1398.HK 0.24%
CCB 939.HK 0.23%
PSBC 1658.HK 0.22%

6.64%

Index Level 2,509.85 (As at 29 July 2022)

Index Avg. Day High-Low Range 25.88 (July 2022)

HSCEI Correlation (2021) 0.624

Hang Seng Mainland Banks Index Futures CM Bank 3968.HK I 0.13%
Contract Multiplier HK$50
Notional Value (1 Contract) HK$0.13Mn (As at 29 July 2022)
Avg. Quote Size HK$0.63Mn (5 Contracts) Index & Constituents 3-Month Performance (Rebased to 100)
Avg. Bid-Ask Trading Spread 133.7 index points (July 2022) 110 - HSMBI CCB (939.HK)
ICBC (1398.HK) BOC (3988.HK)
Liquidity Providers NA 105 - ——ABC (1288.HK)
100
Transaction Cost*
Stam p Duty N/A
90
Trading Fee HK$2 / contract
85
SFC Levy HK$0.54 / contract
) 80 . .
Margin as of 21 Jul 2022 HK$6,660 May-2022 Jun-2022 Jul-2022
Futures contracts have relatively lower transaction costs HSMBI Futures can be used for hedging

Data Source: HKEX, HSIL, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 29 July 2022



Hang Seng Mainland Oil & Gas Index Futures Performance

Hang Seng Mainland Oil & Gas Index (HSMOGI) 5-Min Avg. Bid-Ask Spreads (29 July 2022)

7 largest and most representative

Index Description _ ) )
HKEX-listed mainland oil & gas stocks

HSMOGI Futures 4.84%

Index Level 1,308.67 (AS at 29 JuIy 2022) BG Blue Sky 6828.HK
Index Volatility (30-Day Historical) | 31.1 China Oilfield 2883.HK

Index Avg. Day High-Low Range 16.20 (July 2022
9- Py Hg 9 (duly ) Kunlun Energy 135.HK

HSI Correlation (2021) 0.551
PetroChina 857.HK

HSCEIl Correlation (2021) 0.548

Sinopec Corp 386.HK

Hang Seng Mainland Oil & Gas Index Futures CNOOC 883HK

Contract Multiplier HK$50
Notional Value (1 Contract) HK$65K (As at 29 July 2022)
Avg. Quote Size HK$0.33Mn (5 Contracts) Index & Constituents 3-Month Performance (Rebased to 100)
Avg. Bid-Ask Trading Spread 57.9 index points (July 2022) 120 - e=—HSMOGI —— PetroChina (857.HK)
—— CNOOC (883.HK) Sinopec Corp (386.HK)
Liguidity Providers N/A Kunlun Energy (135.
110
Transaction Cost*
100
Stamp Duty N/A \ ‘
J \/\/
. (AT
Trading Fee HK$2 / contract 90 - \A&t/’\\/‘
SFC Levy HK$0.54 / contract
: 80 T T
Margin as of 21 Jul 2022 HK$5,300 May-2022 JUN-2022 JUk2022
Futures contracts have relatively lower transaction costs HSMOGI Futures can be used for hedging

Data Source: HKEX, HSIL, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 29 July 2022



Hang Seng Mainland Properties Index Futures Performance

Hang Seng Mainland Properties Index (HSMPI) 5-Min Avg. Bid-Ask Spreads (29 July 2022)

10 largest and most representative

Index Description ) ) .
HKEX-listed mainland properties stocks

Fullshare 607.HK 1.61%

Index Level 2,434.70 (As at 29 July 2022) Sino-Ocean Gp 3377.HK

Evergrande 3333.HK

Index Volatility (30-Day Historical) | 47.8
China Vanke 2202.HK

Index Avg. Day High-Low Range 75.72 (July 2022) Country Garden 2007.HK

HSI Correlation (2021) 0.699 HSMPI Futures

HSCEH Correlation (2021) 0.712 China Overseas 688.HK

Longfor PPT 960.HK

China Res Land 1109.HK
Hang Seng Mainland Properties Index Futures
Kerry Ppt 683.HK

Contract Multiplier HK$50

Notional Value (1 Contract) HK$0.12Mn (As at 29 July 2022)

Avg. Quote Size HK$0.6Mn (5 Contracts) Index & Constituents 3-Month Performance (Rebased to 100)

Avg. Bid-Ask Trading Spread 186.0 index points (July 2022) 110 - —HSMPI Evergrande (3333.HK)
China Overseas (688.HK) Country Garden (2007.HK)

Liquidity Providers NA China Res Land (1109.HK)

00 "\—I\\\Jv/\,/

Transaction Cost*

Stamp Duty N/A
Trading Fee HK$2 / contract 70 -
SFC Levy HK$0.54 / contract
Margin as of 21 Jul 2022 HK$16,680 50 T T
May-2022 Jun-2022 Jul-2022
Futures contracts have relatively lower transaction costs HSMPI Futures can be used for hedging

Data Source: HKEX, HSIL, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 29 July 2022



CES120 Index Futures Performance

CES120 Index

Index Description

Index Level

Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range
CSI300 Correlation (2021)

FTSE A50 Correlation (2021)

CES120 Index Futures

Contract Multiplier

Notional Value (1 Contract)
Average Quote Size

Average Bid-Ask Trading Spread

Liquidity Providers

Transaction Cost*

Stamp Duty
Trading Fee
SFC Levy

Margin as of 21 Jul 2022

80 A-Shares and 40 HK-listed Mainland
China H-shares, P-chips, and red chips

5,828.63 (As at 29 July 2022)
235

79.45 (July 2022)

0.897

0.919

HK$50

HK$0.29Mn (As at 29 July 2022)
HK$1.46Mn (5 Contracts)

113.4 index points (July 2022)

N/A

N/A
HK$5 / contract
HK$0.54 / contract

HK$16,980

Futures contracts have relatively lower transaction costs

Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees

Infarmation for reference onlv

As at 29 July 2022

5-Min Avg. Bid-Ask Spreads (29 July 2022)

CES120 Futures — 1.96%
X iShares A50 ETF (2823.HK) . 0.16%
. 0.15%

ChinaAMC CSI300 ETF (3188.HK)

CSOP FTSE A50 ETF (2822.HK) F 0.14%

CES120 & Top Constituents’ 3-Month Performance

(Rebased to 100)

Tencent CCB
——— China Mobile

120 e CES120 Index
——Ping An

110 -

100

90

80 T T
May-2022 Jun-2022 Jul-2022

CES120 Futures can be used to hedge A-share positions
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Hang Seng TECH Index Futures and Options Access Codes

Information Vendor Hang Seng TECH Index Futures Hang Seng TECH Index Options

AAStocks 221014 322400

ACTIV Financial HTIl/<yy><m>.HF HTIl/<yy><mm>/<strike><t>.HF
Bloomberg L.P. HCTA Index HSTECH Index OMON
Colt Technology HTImy HTI<Strikes>my

DB Power Online HTI HTI

DzZH HTI

East Money HTI

Information

ESunny Information ~ HTI HTI

ETNet HTI HTI

Hexin Flush HTI HTI

Infocast Ltd HTI HTI

N2N-AFE 870840 873201-7

QianLong 229

Refinitiv O#HHTI O#HTI*.HF

Shanghai Pobo HTI + Month Code

WebStock HTI HTI

Wind HTIF.HK HTIO.HK

Data Source: HKEX

X



MSCI China A 50 Connect Index Futures Access Codes

Information Vendor MSCI China A 50 Connect Index Futures

AAStocks 221790
ACTIV Financial MCA/<yy><m>.HF
Bloomberg L.P. MCYA Index
Colt Technology MCAmy
East Money Information MCA
ESunny Information MCA

ETNet MCA
Infocast Ltd MCA
N2N-AFE 870939
Refinitiv O#HMCA:
SIX Financial MCAmy
Wind MCAF.HK

Data Source: HKEX

X



MSCI Asia and Emerging Market Index Futures Access Codes

MSCI China |MSCI China |MSCI China i i MSCI EM MSCI EM MSCI EM ex
: NTR (USD) Free NTR i Asia NTR EMEA NTR |China NTR
Information (USD) Index |(USD) Index [|(USD) Index [(USD) Index [(USD) Index |(USD) Index
Vendor Futures Futures Futures Futures Futures Futures
Bloomberg HKCA Index MCYA Index CSIA Index HMSA Index CJEA Index HJEAIndex HQOA Index HQRA Index HRSA Index HQTA Index HQDA Index
Refinitiv O#HMAN:  O#HMCA: O#HCHI:  O#HMCU: O#HCHN: 0#HMCN: 0#HMAC: O#HMAK:  O#HEAN: O#HMEE:  O#HMXC:
WIND MANF.HK  MCAF.HK MCNF.HK EANF.HK

MSCI EM ex i MSCI Hong MSCI
. Korea NTR [ Kong NTR [ MSCI India Indonesia
Information [(UsD) Index (USD) Index NTR (USD) Index (USD) (JPY) Index
Vendor Futures Futures Index Futures |Futures Futures
Bloomberg HQIA Index HQYA Index HMPA Index HMOA Index HLCA Index HRTA Index HJDA Index HMLA Index HKBA Index HQAA Index
Refinitiv O#HMXK: O#HMEL: O#HMEM: O#HEMN: O#HMHN: 0#HMDA: O#HMIN: O#HMID: 0#HMDN: O#HMJIP:
WIND MINF.HK MDNF.HK

MSCI New MSCI Pacific MSCI MSCI
: MSCl Japan  |MSCl Japan |MSCI Malaysia [MSCI Malaysia |Zealand NTR [ex Japan NTR [MSCI Pacific |Philippines ilippi Singapore
Information [NTR (JPY) NTR (USD) (USD) Index  [NTR (USD) (USD) Index  [(USD) Index |NTR (USD) (USD) Index Free (SGD)
Vendor Index Futures |Index Futures |Futures Index Futures |Futures Futures Index Futures |Futures Index Futures |Index Futures
Bloomberg HQBA Index  HJCA Index HMYA Index  HKEA Index HOPA Index HRPA Index HRBA Index  HNSA Index HLEA Index HKOA Index
Refinitiv 0#HMIJ: 0#HMJIU: O#HMMY: O#HMMN: O#HMNZ: O#HMPJ: 0#HMPC: 0#HMPH: 0#HMPN: O#HMSG:
WIND MJUF.HK MMNF.HK

MSCI MSCI Taiwan
: Singapore MSCI Taiwan [MSCI Taiwan [25/50 NTR MSCI Taiwan [MSCI Thailand [MSCI Thailand [MSCI Vietnam [MSCI Vietnam
Information [USD) Index |NTR (USD) (USD) Index  [25/50 (USD)  |(USD) Index  [NTR (USD) (USD) Index  [NTR (USD) (USD) Index  [NTR (USD)
Vendor Futures Index Futures |Futures Index Futures |Futures Index Futures |Futures Index Futures |Futures Index Futures
Bloomberg HOBA Index HKPA Index HJAA Index HRCA Index HRDA Index HJIBA Index HMTA Index HKDA Index HNTA Index HKSA Index
Refinitiv O#HMGN: O#HMSN: O#HMTW: O#HTWP: O#HTWN: O#HMWN: O#HMTH: O#HMTN: O#HMVT: O0#HMVN:
WIND MTWFE.HK MWNF.HK MTNF.HK

Data Source: HKEX

X .



Weekly HSI and HSCEI Options Access Codes

Hong Kong and International Information Vendors

AASTOCKS 322105 322125

Bloomberg HSI Index OMON HSCEI Index OMON

DB Power HSI HHI

ET Net Limited Menu "Futures/Options" > "Futures/Options Quotation (Short-term)“ > Access code: The series name
Infocast HSI HHI

MegaHub Limited HSI HHI

N2N-AFE 873101 873121

Refinitiv <O#HSIW*.HF> <O#HCEIW*.HF>

Tele-Trend File->Open->Options->HSI File->Open->Options->HHI

MSCI AxJ and MSCI AxJ Futures Access Codes

Hong Kong and International Information Vendors

AASTOCKS - 221495
Activ Financial - MXJ/<yy><m>.HF
Bloomberg M1ASJ Index MJSA Index CT
CQG - MXJ

DB Power - MXJ

East Money Information - MXJ
Factset - MXJE

ICE Data Services - F:MXJ
Infocast - MXJ
N2N-AFE - 870823
QPWeb - P11203

SIX Financial Information - MXJImy
Refinitiv .MIAX00000NUS 0#HMXJ:
Telequote Data - MXJ/<yy><m>.HF
Tele-Trend - MXJFC, MXJmyy

Data Source: HKEX

X

21



Sector Index and Sector Index Futures Access Codes

Hong Kong and International Information Vendors

Mainland Banks
Index

Information Vendor

AASTOCKS

Activ Financial =0200700.HK
AFE 837451
Bloomberg HSMBI Index
DB Power

ET Net MBN
Infocast HSMBI
QuotePower SEHK.HHSMBI
Telequote

Refinitiv .HSMBI

Mainland Information Vendors

Mainland Banks
Index

Information Vendor

East Money HSMBI
Hexin Flush Financial

Pobo Financial

Qianlong 999905
Wind HSMBI

Data Source: HKEX

X

Mainland Banks
Index Futures

221420
MBI/16K.HF
870809
BMWA Index

MBI
MBI
MBI

P11223

MBImy
O0#HMBI:

Mainland Banks
Index Futures

MBI
MBIC
MBI+Month+Ye
ar

209

MBIF+yymm-+H
K

Mainland Mainland
Properties Properties Index
Index Futures
221425
=0200800.HK MPI/16K.HF
837451 870810
MSMPI Index PPTA Index
MPI
MPR MPI
MSMPI MPI
SEHK.HHSMPI P11224
MPImy
.HSMPI O#HMPI:
Mainland Mainland
Properties Index | Properties Index
Futures
HSMPI MPI
MPIC

MPI+Month+Year
999902 209

HSMPI MPIF+yymm-+HK

Mainland Oil
& Gas Index

=0201000.HK
837451
HSMOGI Index

MOG

MOGI

SEHK.HHSMO
Gl

.HSMOGI

Mainland Oil
& Gas Index

HSMOGI

999903

HSMOGI

Mainland Oil &
Gas Index
Futures

221415
MOI/16K.HF
870808
OGIA Index

MOl
MOl
MOl

P11222

MOImy
0#HMOI:

Mainland QOil &

Gas Index

Futures

MOI
MOIC
MOI+Month+Ye
ar

209

MOIF+yymm+H
K
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CES120 Index and CES120 Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor | CES 120 Index | CES 120 Index Futures
Bloomberg Finance L.P. CES120 CESA Index DES <GO>
Refinitiv .HKCES120 O#HCHH:
AAStocks.com Limited 110056 221360
AFE Solutions Ltd. 837505 870800

DB Power Online Limited CES120 CHH

ET Net Limited CEC CHH
Infocast Limited CE120 CHH
Interactive Data Group I:CES120 Fn:CHH\MYYDD
Marketprizm Hong Kong Limited CES120 CHHmy
SIX Financial Information Ltd. CES120 CHHmy
Telequote Data International Limited CES120 CHHmy

Mainland Information Vendors

Information Vendor CES 120 Index CES 120 Index Futures

Hithink RoyalFlush Information Network Ltd CES120 CHHC

Shangahai DZH Limited CES120 CHH+Month Code+Year Code
Shanghai Gildata Services Co Ltd CES120 -

Shanghai Wind Information Co., Ltd CES120 CHHF+yymm+.HK
Zheng Zhou Esunny Information Technology Co,

Ltd. i CHH

Shanghai Wenhua Financial Information Ltd - CHHmy

Shanghai Qianlong Advanced Technology Co Ltd CES120 Page 209

Data Source: HKEX

X



